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End-user license agreement

END-USER LICENSE AGREEMENT
BY ACCEPTING, YOU (ORIGINAL PURCHASER) INDICATE YOUR ACCEPTANCE OF THESE TERMS. IF
YOU DO NOT WISH TO ACCEPT THE PRODUCT UNDER THESE TERMS YOU MAY CHOOSE NOT TO
ACCEPT BY SELECTING "I decline..." AND NOT INSTALLING THE SOFTWARE.
The Acronis True Image Personal (the Software) is Copyright © Acronis, Inc., 2000–2005. All rights
are reserved. The ORIGINAL PURCHASER is granted a LICENSE to use the software only, subject to
the following restrictions and limitations.
1. The license is to the original purchaser only, and is not transferable without prior written Permission from
Acronis.

2. The Original Purchaser may use the Software on a single computer owned or leased by the Original

Purchaser. You may not use the Software on more than a single machine even if you own or lease all of
them without the written consent of Acronis.

3. The Original Purchaser may not engage in, nor permit third parties to engage in, any of the following:
A. Providing or permitting use of or disclosing the Software to third parties.
B. Providing use of the Software in a computer service business, network, timesharing or multiple user
arrangement to users who are not individually licensed by Acronis.

C. Making alterations or copies of any kind in the Software (except as specifically permitted above).
D. Attempting to un-assemble, de-compile or reverse engineer the Software in any way.
E. Granting sublicenses, leases, or other rights in the Software to others.
F. Making copies, or verbal or media translations, of the users guide.
G. Making telecommunication data transmission of the software.
Acronis has the right to terminate this license if there is a violation of its terms or default by the
Original Purchaser. Upon termination for any reason, all copies of the Software must be immediately
returned to Acronis, and the Original Purchaser shall be liable to Acronis for any and all damages
suffered as a result of the violation or default.

ENTIRE RISK
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE IS WITH YOU THE
PURCHASER. ACRONIS DOES NOT WARRANT THAT THE SOFTWARE OR ITS FUNCTIONS WILL MEET
YOUR REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR
ERROR FREE OR THAT ANY DEFECTS WILL BE CORRECTED. NO LIABILITY FOR CONSEQUENTIAL
DAMAGES - IN NO EVENT SHALL ACRONIS OR ITS VENDORS BE LIABLE FOR ANY DAMAGES
WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR THE LOSS OF BUSINESS
PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER
PECUNIARY LOSS) ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF
ACRONIS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Copyright © Acronis, Inc., 2000–2005

3

Table of contents

Table of Contents
CHAPTER 1.
1.1
1.2
1.3
1.4
1.5

INTRODUCTION............................................................................................... 6
What is Acronis True Image Personal?........................................................................ 6
Acronis True Image Personal key features .................................................................. 6
What is a disk image? ............................................................................................... 7
Acronis True Image Personal upgrade ........................................................................ 7
Software usage terms and conditions ......................................................................... 8

CHAPTER 2.
2.1
2.2
2.3
2.4

INSTALLATION AND OPERATION.................................................................... 9
System requirements ................................................................................................ 9
Acronis True Image Personal installation..................................................................... 9
Running Acronis True Image Personal ........................................................................ 9
Removing the program............................................................................................ 10

CHAPTER 3. GENERAL PROGRAM INFORMATION ............................................................. 11
3.1
Main program window............................................................................................. 11
3.1.1
3.1.2
3.1.3

Program menu ........................................................................................................................ 12
Status bar ............................................................................................................................... 12
Disk and partition information .................................................................................................. 12

3.2.1
3.2.2
3.2.3
3.2.4

Creating Acronis Secure Zone...................................................................................................13
Resizing Acronis Secure Zone ...................................................................................................14
Deleting images in Acronis Secure Zone.................................................................................... 15
Deleting Acronis Secure Zone...................................................................................................16

3.2

3.3

Acronis Secure Zone ............................................................................................... 13

Acronis Startup Recovery Manager ........................................................................... 16

CHAPTER 4.
4.1
4.2
4.3
4.4
4.5
4.6
4.7

CREATING A PARTITION (DISK) IMAGE ....................................................... 18
Selecting partitions ................................................................................................. 18
Selecting image location.......................................................................................... 18
Selecting image file size .......................................................................................... 19
Selecting data compression level.............................................................................. 20
Protecting images with passwords............................................................................ 21
Providing comments ............................................................................................... 22
Image creation script .............................................................................................. 23

CHAPTER 5.
5.1
5.2
5.3
5.4
5.5
5.6
5.7
5.8
5.9
5.10

RESTORING A DISK (PARTITION) FROM AN IMAGE..................................... 25
Selecting an image to restore from........................................................................... 25
Checking image integrity before restoration .............................................................. 26
Selecting a partition to restore ................................................................................. 27
Selecting a location to restore to.............................................................................. 27
Selecting partition type ........................................................................................... 28
Selecting a file system............................................................................................. 29
Selecting restored partition size ............................................................................... 30
Assigning a letter to a partition ................................................................................ 31
Restoring several partitions at once.......................................................................... 32
Restoration script ................................................................................................... 33

CHAPTER 6. BROWSING AND RESTORING INDIVIDUAL FILES ........................................ 34
6.1
Connecting a virtual disk ......................................................................................... 34
6.1.1
6.1.2

6.2

Selecting an image .................................................................................................................. 34
Selecting partitions to connect and letter assignment................................................................. 35

Unplugging a virtual disk ......................................................................................... 35

CHAPTER 7. OTHER OPERATIONS ..................................................................................... 37
7.1
Checking images .................................................................................................... 37
7.1.1

4

Selecting image for checking.................................................................................................... 37
Copyright © Acronis, Inc., 2000–2005

Table of contents

7.2

Creating bootable media ......................................................................................... 37

CHAPTER 8. TROUBLESHOOTING...................................................................................... 39
8.1
Recovering Acronis True Image Personal .................................................................. 39
8.2
Frequently asked questions ..................................................................................... 39
8.3
Technical support ................................................................................................... 41
APPENDIX A. PARTITIONS AND FILE SYSTEMS ................................................................ 42
A.1
Hard disk partitions................................................................................................. 42
A.2
File systems ........................................................................................................... 42
A.2.1
A.2.2
A.2.3
A.2.4
A.2.5
A.2.6

FAT16..................................................................................................................................... 43
FAT32..................................................................................................................................... 43
NTFS ...................................................................................................................................... 43
Linux Ext2............................................................................................................................... 44
Linux Ext3............................................................................................................................... 44
Linux ReiserFS......................................................................................................................... 44

Copyright © Acronis, Inc., 2000–2005

5

Introduction

Chapter 1.
1.1

Introduction

What is Acronis True Image Personal?
Acronis True Image Personal solves all backup problems, ensuring the safety of all
information on your PC.
Using it, you'll be able to create exact hard disk images, including all operating
systems, applications and configuration files, software updates, personal settings
and all of your data.
If failures occur that block access to information or affect system operation, or if
you accidentally delete necessary files, you'll be able to restore the system and lost
data easily.
You won't have to select files and folders for backup, as many backup applications
require. Instead, you will store all your disk data. As a result, Acronis True Image
Personal is simpler and faster than competitive applications.
You can create images on local hard disks, CD-R/RW, DVD+R/RW, DVD-RW, or a
variety of removable media, such as FireWire (IEEE-1394) and USB (1.0, 1.1 and
2.0) devices.
You can restore the partition or lost data from an image any time. You can also
connect an image as a virtual drive, browse its contents and extract selected files to
the hard disk.
The unique technology developed by Acronis and implemented in Acronis True
Image Personal allows you to create exact, sector-by-sector disk images and restore
their content directly from Windows without the reboots typical for similar
products.
Wizards and a user-friendly, Windows XP-styled interface will make your work even
more convenient. Just answer some simple questions and let Acronis True Image
Personal take care of everything else! When a problem occurs, it will get you up and
running in short order.

1.2

Acronis True Image Personal key features
Acronis True Image Personal allows you:
• Create and restore disks or partitions images;
• Connect a partition image file as a virtual disk;
• Check image data integrity at any time;
• Create a hidden partition (the Acronis Secure Zone) for image files storage;
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• Run Acronis True Image Personal from bootable diskette or CD, and thus restore
data from images, even if your operating system does not boot;
• Create a complete or safe version of boot disk.

1.3

What is a disk image?
A disk (partition) image is a file that contains a copy of all information stored on a
disk. The image stores the installed operating system, all programs, and all
documents and settings.
By backing up your information regularly, you will protect yourself from data loss in
case of system failure or PC malfunctions.
To recover your system in case of disaster, simply restore the corrupted disk
(partition) data from its image. This will ensure the exact restore of disk (partition)
state, critical in some situations.
By default, Acronis True Image Personal image files have a “.tib” extension and can
contain images of several partitions or disks.
Images of large partitions or several disks could be quite large. If so, they can be
split into several files that together make an original image. A single image can also
be split for burning to removable media. A single image that is split across multiple
CDs is sometimes called a “spanned volume.”
Acronis True Image Personal stores only those hard disk parts that contain data (for
supported partition types). This reduces image size and speeds up image creation and
restoration.
A partition image includes all files and folders independent of their attributes (including hidden
and system files), boot record, FAT (file allocation table) and root.
A disk image includes images of all disk partitions as well as the zero track with master boot
record (MBR).

1.4

Acronis True Image Personal upgrade
To use additional features, provided by Acronis imaging products, upgrade to the
full version of Acronis True Image. For more information about the update and the
special savings for Acronis True Image Personal owners, please refer to:
http://www.acronis.com.
With the full Acronis True Image version you can:
• Create incremental backup images, containing only changes occurred since the
previous image had been created;
• Store image files on network drives;
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• Shedule backup operations;
• View logs (the history of the program operation);
• Set image creation process priority;
• Check the disk (partition) file system integrity after restoration;
• Easily clone data from one hard disk to another.

1.5

Software usage terms and conditions
The conditions for Acronis True Image Personal software usage are described in the
«License Agreement» (page 3 of this manual). The unique registration number is a
confirmation of your legal purchase and usage of Acronis True Image Personal on
your system.
Under current legislation, the «License Agreement» is considered a contract
between you and Acronis Inc. The contract is a legal document and its violation may
result in legal action.
Illegal use and/or distribution of this software will be prosecuted.

8
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Chapter 2.
2.1

Installation and operation

System requirements
Acronis True Image Personal requires the following hardware:
• Pentium CPU and higher
• 64 MB RAM
• floppy disk drive or CD-RW drive for bootable media creating
• mouse (recommended)

2.2

Acronis True Image Personal installation
To install Acronis True Image Personal:
1.

Insert the installation CD into your drive.

2.

Follow the instructions on the screen.

3.
After making your installation choices and copying Acronis True Image
Personal files onto your hard disk, you will be prompted to create a bootable
diskette or CD-R/W. While Acronis True Image Personal creates disk images in
Windows, it might be necessary to run restoration procedure from a bootable disk.
Therefore, it is strongly recommended that you create one. However, you can do
that after the installation as well.
After installation of Acronis True Image Personal is completed, you should restart
your computer.

2.3

Running Acronis True Image Personal
In normal mode, you can run Acronis True Image Personal from Windows by
selecting Acronis → True Image → Acronis True Image Personal from Start
→ Programs. This will bring the program window onto the screen.
If your operating system does not load for some reason, you can run Acronis
Startup Recovery Manager. However, this must be activated prior to use; see
"Acronis Startup Recovery Manager" to learn more about this procedure. To run the
program, press F11 during PC bootup, when you see a corresponding message that
tells you to press that key. Acronis True Image Personal will be run in the
standalone mode, allowing you to restore previously created images.
If your disk data is totally corrupted and you can not boot (or if you have not
activated Acronis Startup Recovery Manager), you should use the bootable media
created during the installation procedure or later. It will automatically load Acronis
True Image Personal, allowing you to recover the damaged partitions.
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2.4

Removing the program
To remove Acronis True Image Personal from your PC, select Acronis → True
Image → Uninstall Acronis True Image Personal in the Programs menu. You
will see a dialog to confirm the program removal. Click Yes to confirm and Acronis
True Image Personal will be completely removed. You may have to reboot your
computer afterwards to complete the task.
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Chapter 3.
3.1

General program information

Main program window
The main program window contains the menu, toolbar and the Windows XP
Explorer-like interface divided into two areas. The right area contains operation
icons; the left one has corresponding action descriptions, typical actions and
additional tools.

The main program window
The menu, toolbar and menu items in the left area duplicate themselves, providing
more convenience.
Having selected (clicked) an operation, you can execute it in several ways: by
double-clicking its icon, by selecting Start Now in the Operations menu, by
selecting the same operation in the Operations window, or by clicking Start on
the toolbar.
The main window contains disk imaging operation icons:
• Create Image – create a disk (partition) image
• Restore Image – restore a disk (partition) from a previously created image
• Explore Image – connect and view an image as a virtual drive
• Unplug Image – disconnect the connected virtual drive
Copyright © Acronis, Inc., 2000–2005
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3.1.1

Program menu
The program menu line contains the Operations, View, Tools and Help items.
The Operations menu contains Start Now item to execute the selected operation
and Exit to exit the application.
The View menu contains items for managing the program window look:
• Toolbars – contains commands that control toolbar icons
• Common Task Bar – enables/disables common task panel in the left area
• Status Bar – enables/disables the status bar
• Tiles Icons List – controls how operation icons look
• Refresh – refreshes the main program window
The Tools menu contains the following items:
• Manage Acronis Secure Zone – creates a special hidden system partition on a
disk for storing disk (partition) images
• Activate Acronis Startup Recovery Manager – activates the boot restoration
manager
• Check Image – runs disk (partition) integrity checking procedure
• Create Bootable Rescue Media – runs the bootable media creation procedure
The Help menu allows you to invoke help and get information about Acronis True
Image Personal.

3.1.2

Status bar
In the bottom of the main window, there is a status bar. Its left part briefly
describes the selected operation.

3.1.3

Disk and partition information
You can change disk schemes and data representation in all schemes you see in
various wizards.
To the right are three icons: Arrange Icons by, Choose Details and i (Display
the properties of the selected item) (the last duplicated in the context menu
invoked by right-clicking objects).
To sort messages by a particular column, click the header (another click will switch
to the opposite order) or Arrange Icons by button and select the column.
To select columns to view, right-click the headers line or left-click the Choose
Details button. Then flag the columns you want to display.

12
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If you click the i (Display the properties of the selected item) button, you will
see the selected partition or disk properties window.
This window contains two panels. The left panel contains the properties tree and
the right describes the selected property in detail. The disk information includes its
physical parameters (connection type, device type, size, etc.); partition information
includes both physical (sectors, location, etc.), and logical (file system, free space,
assigned letter, etc.) parameters.
You can change the width of columns by dragging their borders with the mouse.

3.2

Acronis Secure Zone
Acronis Secure Zone is a special, hidden system partition for storing disk and
partition images. Ordinary applications can’t access it, for image security purposes.
If you create a zone, it will be listed along with all partitions available for image
creation and restoration.
The Acronis Secure Zone is primarily meant to be used with Acronis Startup
Recovery Manager (see below). However, it can be used to store data as well as
image files.
The zone is always available for image creation as long as there is space for it. If
there is not enough space, older images will be deleted to create space.
A PC can have only one secure zone. To create a zone on another disk, you must
first delete any existing zone.
When you click Manage Acronis Secure Zone in the menu, the program searches
for the zone on all local drives. If a zone is found, the wizard will offer to delete or
resize it. If there is no zone, you’ll be prompted to create it.
Before you create the zone, estimate its size. To do this, start image creation and
select disks and partitions to image into the zone. At the compression level stage,
you will see estimated image size. Multiply this by 1.5 to compensate possible
inaccuracy of estimation. If you plan to install additional applications onto selected
disks, further increase the zone size.

3.2.1

Creating Acronis Secure Zone
If there are several disks installed, select one on which to create Acronis Secure
Zone.
Select the partitions from which space will be used to create the zone.

Copyright © Acronis, Inc., 2000–2005
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Select the partitions to give space for Acronis Secure Zone
In the next window, enter the size of the zone or drag the slider.
After this, you will be prompted to activate Acronis Recovery Manager, allowing to
start Acronis True Image Personal at boot time by pressing F11 key. Alternatively,
you can activate this feature later from main program window.
Then you will see a zone creation script containing a list of operations to be
performed on partitions (disks).
After you click Proceed, Acronis True Image Personal will start creating the zone,
indicating the progress in the special window. You can stop this procedure by
clicking Cancel. However, the script will be canceled only after the current
operation is finished.
Acronis Secure Zone creation might take several minutes or more. Please wait until
the whole procedure is finished.

3.2.2

Resizing Acronis Secure Zone
When prompted by the wizard, select Manage Acronis Secure Zone.
Select to increase or decrease the zone. You might need to increase it to provide
more space for images. The opposite situation might arise if either partition lacks
free space.
After this, select a partition from which free space will be used to increase Acronis
Secure Zone or that will receive free space after the zone is reduced.

14
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In the next window, enter the new size of the zone or drag the slider.

Set the new size for Acronis Secure Zone.
Then you will see a zone resize script containing a list of operations to be performed
on partitions (disks).
After you click Proceed, Acronis True Image Personal will start resizing the zone,
indicating the progress in the special window. You can stop this procedure by
clicking Cancel. However, the script will be canceled only after the current
operation is finished.
Acronis Secure Zone resizing might take several minutes or more. Please wait until
the whole procedure is finished.

3.2.3

Deleting images in Acronis Secure Zone
The images saved to Acronis Secure Zone are deleted automatically if required.
Acronis True Image Personal uses the following scheme to clean up Acronis Secure
Zone:
• If there is not enough free space in Acronis Secure Zone to create an image,
then Acronis True Image Personal deletes the most old image.
You can always check how much free space left in Acronis Secure Zone on the
second page of the Manage Acronis Secure Zone wizard.

Copyright © Acronis, Inc., 2000–2005
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3.2.4

Deleting Acronis Secure Zone
When prompted by the wizard, select Remove Acronis Secure Zone.
Select partitions to which you want to add the space freed from Acronis Secure
Zone.

Select the partitions to receive space from Acronis Secure Zone
Then you will see a zone deletion script containing a list of operations to be
performed on partitions (disks).
After you click Proceed, Acronis True Image Personal will start deleting the zone,
indicating the progress in the special window. You can stop this procedure by
clicking Cancel. However, the script will be canceled only after the current
operation is finished.
Acronis Secure Zone deletion might take several minutes or more. Please wait until
the whole procedure is finished.
Acronis Secure Zone deletion will disable Acronis Startup Recovery Manager automatically if it
is activated and destroy all images stored in the zone.

3.3

Acronis Startup Recovery Manager
Acronis True Image Personal provides Acronis Startup Recovery Manager to run the
program without loading the operating system. This feature is useful if Windows

16
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won't load for some reason. Using it, you can run Acronis True Image Personal by
itself to restore damaged partitions from images.
To use Acronis Startup Recovery Manager (it must be activated), turn on your PC
and press F11, when you see the "Press F11 for Acronis Startup Recovery Manager"
message. This will run a standalone version of Acronis True Image Personal that
only slightly differs from the complete version. For information on restoring
damaged partitions, see Chapter 5.
Be careful! Disk letters in standalone Acronis True Image Personal might sometimes differ
from Windows notation.

To activate the program, click Activate Acronis Startup Recovery Manager.
Acronis Startup Recovery Manager cannot be activated if Acronis Secure Zone is
missing on the hard disk. If you have not created this Zone before, you will be
prompted to create it (see section 3.2.1 above), then Acronis Startup Recovery
Manager will be activated. Otherwise, Acronis Startup Recovery Manager will be
activated immediately.
When Acronis Startup Recovery Manager is activated it overwrites the Master Boot Record
(MBR) with its own boot code. If you have any third party boot managers installed, then you
will have to reactivate them after activating the Startup Recovery Manager. For Linux loaders
(e.g. LiLo and GRUB) you might consider installing them to a Linux root (or boot) partition
boot record instead of MBR before activating Acronis Startup Recovery Manager.

Copyright © Acronis, Inc., 2000–2005
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Chapter 4.
4.1

Creating a partition (disk)
image

Selecting partitions
In the Selecting partitions to Image window, you will see the hard disk layout of
your PC. Flag a partition to select it. Flag a whole disk to select all its partitions to
image. You can select one or more hard disks or any combination of partitions and
hard disks.

Disk and partition layout
Having selected partitions and/or disks, click Next. Note that this button is disabled
if no partitions or disks are selected.
Acronis True Image Personal does not include swap file information (win386.swp under
Windows 98/Me and pagefile.sys under Windows NT/2000/XP), or hiberfil.sys (a file that
keeps RAM contents when the computer goes into hibernation). This considerably reduces
the image size and increases the speed of creating the image.

4.2

Selecting image location
Specify the image location on the hard disk (you can use Acronis Secure Zone), CDR/RW, DVD-recordable, or removable media, such as FireWire (IEEE-1394) or USB
(1.0, 1.1 and 2.0) device.

18
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You should have DVD UDF recording software installed for burning images on DVD disks, for
example: Roxio DirectCD, Ahead InCD and other the same.

Image location selection
Select the image location in the disk tree. In the File name field, enter image file
name. If you select Acronis Secure Zone, you don't have to provide a name.
If there's already an image file with that name, Acronis True Image Personal will ask
if you want to overwrite it.
You can store several partitions and/or disks images in a single file.

The program can generate an unique filename. Just click Generate file name for a new
file button at the right.

4.3

Selecting image file size
With this step, you can specify if the program should create a single file or split it
into equal smaller images.
If you select Automatic, Acronis True Image Personal will try to decide this for
every case. If there's enough space on the selected disk, the program will create a
single image file.

Copyright © Acronis, Inc., 2000–2005
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If there is not enough space, Acronis True Image Personal will warn you and wait
for your decision. You can try to free some additional space and continue or stop
Acronis True Image Personal, free some space and re-execute the procedure.

Image file size selection
If the image is destined for removable media, the image file size is set automatically.

FAT16 and FAT32 file systems have a 4 GB limit for maximum file sizes. FAT32 is currently the
most popular end user file system. At the same time, existing hard drives have capacities of
160GB and larger! Therefore, an image file might easily exceed this limit. In that case, Acronis
True Image Personal will automatically split the image into several files.

When creating an image automatically on CD-R/RW, DVD-RW, DVD+R/RW
media, Acronis True Image Personal asks you to insert a new disk when the
previous one is full.
You can also fix image file size by selecting Fixed size and entering the desired
size or selecting it from the drop-down list. By default, the value is in bytes, but you
can also use kilobytes and megabytes.
You can split the image file into several volumes when storing it on a hard drive. Later you'll
be able to easily transfer these files onto CD-R/RW, DVD-R/RW, DVD+R/RW. Creating images
directly on CD-R/RW, DVD-RW, DVD+R/RW might take considerably longer time than it would
on a hard disk.

4.4

Selecting data compression level
Now you must select the data compression level for the image to be created.
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If you select None, all data will be transferred into an image file as they are,
increasing the image size. Maximum compression might reduce the program
performance and prolong image creation.

Image data compression level selection
The optimal data compression level depends on disk (partition) file types and can
only be understood empirically.
Usually, it is recommended that you leave the switch in the Normal position. If you
need to burn an image to removable media, you can select Maximum
compression.

4.5

Protecting images with passwords
An archive file with a partition (disk) image can be protected with a password. To
protect a partition (disk) from being restored by anybody except you, enter a
password and its confirmation into the text fields of the wizard page Image
Archive Protection. A password should consist of at least eight symbols and
contain both letters (in the upper and lower cases preferably) and numbers to make
it more difficult to guess.

Copyright © Acronis, Inc., 2000–2005
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Image password protection
If you try to restore data from a password-protected image, Acronis True Image
Personal will ask for the password in a special window, allowing access only to
authorized users.

4.6

Providing comments
On the Image Archive Comments wizard page, you’ll be able to provide an
archive file with comments about the PC and its user, the hard disk, partition data,
image creation time, and any peculiarities and conditions.

22
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An image comment
The more details you provide in the comments, the better. If you don’t provide
comments, you might mistake images and restore the wrong system partition, for
example.

4.7

Image creation script
In the next window, you will see a disk or partition image creation script containing
a list of operations to be performed.

Copyright © Acronis, Inc., 2000–2005
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Image creation script
All operations of a partition (disk) image creation in an archive file are delayed in
Acronis True Image Personal. A partition (disk) image creation script is created first;
then it is executed.
After you click Proceed, Acronis True Image Personal will start creating an image,
indicating the progress in the special window. You can stop this procedure by
clicking Cancel.
You can also close the progress window by clicking Close. Image creation will
continue, but you will be able to start another operation or close the main program
window. In the latter case, the program will continue working in the background
and will automatically close once the image is ready. If you prepare some more
image creation operations, they'll be queued after the current one.
If you are to burn an image to several removable media, be sure to number them, since you
will have to insert them in order during the restoration.
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Chapter 5.

Restoring a disk (partition)
from an image

As mentioned above (see "Running Acronis True Image Personal"), Acronis True
Image Personal can be run in several ways. However, disk restoration is always
performed just one way.
We recommend that you restore disks using Windows, only using other methods if
Windows doesn’t load.
The boot disk (e.g. a CD) from which you loaded the program does not keep you
from using other CDs with images. Acronis True Image Personal is loaded entirely
into RAM, so you can remove the bootable CD to insert an image disk.
To restore a partition (disk) from an image, Acronis True Image Personal must
obtain exclusive access to this partition (disk). This means no other applications
can access it at that time. If you receive a message stating that the partition (disk)
can not be blocked, close applications that use this partition (disk) and start over. If
you can not determine which applications use the partition (disk), close them all.

5.1

Selecting an image to restore from
Find and select a file containing an image of the required partition. The File Name
field will reflect its name and the Next will become available. If this image is
located in Acronis Secure Zone, select it to choose the image on the next step.

Image selection for restoration
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If you are to restore an image from removable media, e.g. CD, first insert the last CD and
then follow instructions of the Restore Image Wizard.

If you provided a comment to the image, it will help you know if you selected the
right image to restore. The comment is displayed in the right part of the window.
Note that the comment can be seen without entering a password for a protected
image. However, the contents of such an image will still require a password.
If an image was protected with a password, Acronis True Image Personal will ask
for it. The Next button will be disabled until you enter the correct password.

5.2

Checking image integrity before restoration
Before an image is restored, Acronis True Image Personal can check its integrity.
To do this, flag Yes, I want to verify the image archive on the Verify Archive
Before the Restoring page of the image restoration wizard.

Checking image integrity before restoration
This is disabled by default in Acronis True Image Personal.
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5.3

Selecting a partition to restore
A single file might contain images of several partitions or even disks, as shown in
the figure below.

Select a partition to restore
During a single session, you can restore several partitions or disks, one by one, by
selecting one disk and setting its parameters first and then repeating these actions
for every partition or disk to be restored.
Select the necessary partition and click Next.

5.4

Selecting a location to restore to
As a rule, you should restore an image to the same partition from which the image
was created.
It is possible to restore an image to another partition. A partition should be at least
the same size as the uncompressed image data.
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Select partition to restore image to
All the data stored on the restored partition will be replaced by the image data, so be careful
and watch for non-backed-up data that you might need.

5.5

Selecting partition type
When restoring a partition, you can change its type, though it’s not required in most
cases.
To explain why you might need to do this, let’s imagine that both OS and data were
stored on the same primary partition on the damaged disk. You are forced to
restore the partition from a backup to another hard disk with its own partitions and
OS.
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Select partition type
If you need only the data, you do not have to create another primary partition. In
this case, you can restore the partition as a logical partition to access the data only.
But if you are to restore a system partition, you should select the Primary type for
it. Finally, if you want to load an operating system from it, select Active as well.
Selecting Active for a partition without an installed operating system could prevent your PC
from booting.

5.6

Selecting a file system
Though it is seldom required to change a partition file system, you can change it
during its restoration. For partitions with FAT native file systems you can choose
between FAT16 and FAT32. For partitions with Ext native file systems you can
choose between Ext2 and Ext3. For partitions with other native file systems this
option is not available.
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Select a file system
Let’s imagine you are to restore a partition from an old, low-capacity FAT16 disk to
a newer disk. FAT16 would not be effective and might even be impossible to set on
the high-capacity hard disk. That's because FAT16 supports files up to 4 GB, so you
won’t be able to restore a 4 GB FAT16 partition to a disk that exceeds that threshold
without changing the file system.
It would make sense here to change the file system from FAT16 to FAT32 by setting
the appropriate software switch.
But you must also keep in mind that not all operating systems support FAT32. MSDOS, Windows 95 and Windows NT 3.x, 4.x do not support FAT32 and will not be
operable after you restore a partition and change its file system. These can be
normally restored on a FAT16 partition only.
However, you can easily convert a FAT16 partition with newer OS into FAT32.
The operating systems summary is provided in Appendix A.

5.7

Selecting restored partition size
In some cases, you might need to change the partition configuration and size during
restoration. Acronis True Image Personal is flexible enough to do this.
You can resize and relocate a partition by dragging it or its borders with mouse or
by entering corresponding values into the appropriate fields.
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Select partition size and location
You might need to resize and relocate a partition in order to redistribute the disk space
between existing partitions. In this case, you will have to restore the partition to be reduced
first.

5.8

Assigning a letter to a partition
Windows utilizes letters to identify disks and partitions, automatically assigning
them at loading.
Under Windows NT/2000/XP, Acronis True Image Personal enables you to assign
any unused letter to a restored partition (logical disk). To do this, select Yes, I
want to assign a logical drive letter to restored partition. If you don’t set
this switch, no letters will be assigned to the restored partition, hiding it from OS.
Under Windows 9x/Me, this step is bypassed since letters are assigned
automatically.
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Assign any unused letter to a partition
You should not assign letters to partitions inaccessible to Windows, such as to those
other than FAT and NTFS.

5.9

Restoring several partitions at once
You can restore several partitions during a single session. To do this, select Yes, I
want to restore another partition or hard disk drive in the Next Selection
window and click Next.
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You can restore another partition during this operation
After this, you will see the partition selection window again and will have to repeat
the actions mentioned above.
If you want to restore only one disk (partition) or have already selected all of the
partitions you need, don’t set this switch and click Next.

5.10

Restoration script
In the next window, you will see a disk or partition image restoration script
containing a list of operations to be performed.

Restoration script
After you click Proceed, Acronis True Image Personal will start image restoration,
indicating the progress in the special window. If you click Cancel, no changes will
be made to disk(s).
You can also stop the procedure by clicking Cancel. However, it is critical to note
that the partition that should have been restored from the image will be deleted and
its space unallocated – the same result you will get if the restoration is
unsuccessful. To recover the “lost” partition, you will have to restore it from the
image again.
After the restoration is finished, you will see a message about its results.
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Chapter 6.

Browsing and restoring
individual files

To browse and restore individual files, Acronis True Image Personal can connect
images as virtual drives, thus letting you access them as though they were a
physical drive. This means that:
• A new disk with its own letter will appear in the drives list
• Using Windows Explorer and other file managers, you will be able to see image
files as if they were located on a physical disk or partition
• You’ll be able to find necessary files or folders in order to copy them from the
virtual disk to the real one.
The connected virtual drive will be read-only and you won’t be able to change
anything within it.

6.1

Connecting a virtual disk
Use Explore Image to connect an image as a virtual disk and click Next in the
first wizard window.

6.1.1

Selecting an image
In the next window, specify the image you want to open as a virtual disk.

Select image to connect

34

Copyright © Acronis, Inc., 2000–2005

Browsing and restoring individual files

If the selected image file is not protected by a password, you will immediately see
the image comment along with the list of stored partitions. If the file is protected by
a password, you will see only the comment.

6.1.2

Selecting partitions to connect and letter assignment
You must select a partition to connect as a virtual disk. Note that you can’t connect
the entire disk.

Select partition to connect
You can also select a letter to be assigned to the connected disk (from the partition
letter drop-down list.)
In the next window, you will see a disk-connection script containing a single
operation. Click Proceed to connect the image as a virtual disk.
After the disk is connected, the program will run Windows Explorer showing its
contents.
Now you can easily copy any file (or folder) from the virtual disk to the real one
using Windows Explorer or a similar file manager.

6.2

Unplugging a virtual disk
We recommend that you unplug a virtual disk after all necessary files and folders
are copied. However, the virtual disk will disappear after your PC is turned off.
To disconnect the virtual disk, right-click on its name and select Unplug.
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You can also unplug the disk by clicking Unplug Image in the Acronis True Image
Personal main window.
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Chapter 7.
7.1

Other operations

Checking images
To be assured that your images are not damaged, you can check their integrity. To
do this, select Check Image in the Tools group (expand it if it's not) or click
Check Image on the toolbar. You will see the first wizard window. Click Next to
continue.

7.1.1

Selecting image for checking
In this window, you will see the complete list of connected storage devices,
including hard disks and other drives. Using Windows Explorer, locate the image file
to be checked and select it.
Its name will appear in the File Name field and the Next button will be enabled.

Select image to check
Click Proceed to continue. Progress will be indicated in the new window.
You can cancel checking by clicking Cancel.
After checking is complete, you will see the results window.

7.2

Creating bootable media
In some cases, Acronis True Image Personal can be run only from a special
bootable diskette or CD. Such a case might be if your PC doesn’t boot up normally.
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You can create bootable media during or after the installation (if you have
purchased the boxed product that contains a bootable CD, you need not create it
yourself).
For this, you will need a CD-R/RW blank, five formatted diskettes (or two for the
safe variant), or any other media your PC can boot from, such as a Zip drive.
Click Create Rescue Media on the toolbar or in the left part of the main window,
or select Create Rescue Media from the Tools menu.
You can also create bootable media without loading Acronis True Image Personal
itself by selecting Programs → Acronis → True Image → Bootable Rescue
Media Builder from the Start menu.
You will see the bootable media wizard that will ask you to select either complete or
safe loader version. The latter doesn't have some devices drivers and is useful only
in case the complete version doesn’t work.
After you create a boot disk, identify it and keep it in a safe place.
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Chapter 8.
8.1

Troubleshooting

Recovering Acronis True Image Personal
If Acronis True Image Personal ceases running or produces errors, its files might be
corrupted. To fix it, you will have to recover the program. To do this, run the
installer again. It will detect Acronis True Image Personal on your PC and will ask
you if you want to recover (update) or remove it.
Click Recover and click Proceed.

8.2

Frequently asked questions
How do I use Acronis True Image Personal on a Linux-based PC?
Acronis True Image OEM Edition supports the most popular Linux file systems,
including Ext2, Ext3 and ReiserFS.
Acronis True Image Personal can be run from a special bootable diskette or CD
independently of operating system installed.
Having been run this way, it allows you to perform any disk (partition) image
creation or restoration operations on a Linux-based PC.
What storage devices does Acronis True Image Personal support for
keeping backups?
Backups can be created on hard disks, and other storage devices supported by
Windows 98/Ме/NT 4/ 2000/XP.
What is the purpose of specifying image file size?
The PC hard disk is the fastest and most effective storage device. It can write a disk
(partition) image considerably faster than any other device, such as a CD-R/RW.
Having specified image volume size equal to 600–650Mb, you can quickly create
image files on your hard disk that you can burn to CD-R/RW, DVD+R/RW or DVDRW afterwards. This allows you to do the entire task much more quickly.
What devices can a system partition be restored from if Acronis True
Image Personal is loaded from its bootable diskette or CD?
Acronis True Image Personal supports any connected hard disks as well as CDR/RW, DVD+R/RW, DVD-RW and a wide variety of FireWire (IEEE-1394) and USB
(1.0, 1.1, 2.0) devices.
Can Easy CD Creator 4.x–5.0 impede Acronis True Image Personal?
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Easy CD Creator 4.x and 5.0 automatically installs an old version of Take Two®
backup utility that is no longer supported by its manufacturer, Roxio. If Acronis True
Image Personal detects this utility, it shows you the following message in the
beginning of image creation:
"Can’t create the image of the logical disk, as it’s already used by a running
application. Please close all other applications and try again."
We recommend that you update your Easy CD Creator to Version 5.1 or newer
and/or completely remove Take Two®.
For more information, visit
http://www.roxio.com/en/support/roxio_support/taketwo.html
Is Acronis True Image Personal compatible with Roxio GoBack?
Yes, Acronis True Image Personal is compatible with Roxio GoBack under Windows.
If you want to load Acronis True Image Personal from its bootable media, you will
have to disable Roxio GoBack first.
Note that Roxio GoBack will be deleted from your hard disk during the restoration.
I created an image on CD-R/RW disks, but when I try to browse it,
Acronis True Image Personal tells me it can’t connect this image as a
virtual disk.
The current version of Acronis True Image Personal can connect images only if their
files are located in the same place. If your image is located on several CD-R/RW or
hard disks, you will have to copy all its files to a single folder on your hard disk.
I received the "Can’t create image of disk D:, because it’s already used by
applications or contains bad sectors" error message, where D: stands for
my logical disk, when I tried to create an image under Windows.
Your logical disk might contain bad sectors. We recommend that you run a
complete disk surface test. Under Windows 98/Me, run scandisk and perform the
complete disk check. Under Windows NT/2000/XP, type “chkdsk /R D:” in the
command line and reboot.
How can I burn Acronis True Image Personal images to DVD?
Acronis True Image Personal can burn images to DVD under Windows, if you have
DVD UDF recording software installed. The DVD must be formatted. Currently, the
program supports at least the following DVD recording software:
• Roxio DirectCD — optional component of Roxio Easy CD Creator;
• Ahead InCD — available on Nero website freely for Ahead Nero Burning Rom
users (usually bundled with Nero);
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• Veritas DLA and all its OEM versions (e.g. HP DLA);
• Pinnacle InstantCD/DVD
In general, the program also supports all other DVD UDF burst recording software,
but the aforementioned applications were tested by Acronis for compatibility with
Acronis True Image Personal.
To enable image recording to DVD in Acronis True Image Personal, you should do
the following:
• Install DVD UDF recording software.
• Format DVD disks. DVD+RW and DVD-RW disks can be formatted in any of the
aforementioned applications, while DVD+R formatting is currently supported by
Roxio DirectCD only.
• Run Acronis True Image Personal, insert a formatted DVD into your DVD+RW or
DVD-RW drive and create an image. No other special actions are required.
Images stored on DVD can be restored under Windows and when Acronis True
Image Personal is loaded from its boot disk.
There is another way to burn an image to DVD. Using Acronis True Image Personal,
you can create an image on your hard disk and burn it using the installed DVD
recording application to a DVD disk afterwards. You will be able to restore images
from such disks under Windows and when Acronis True Image Personal is loaded
from the bootable media.

8.3

Technical support
Users of legally purchased copies of Acronis True Image Personal are entitled to
free e-mail technical support from Acronis. If you have installation or working
problems that you can’t solve by yourself using this manual and the readme.txt file,
e-mail the technical support team.
Before you do this, you will have to register your copy at
http://www.acronis.com/registration/ or by mail.
When e-mailing technical support, you must provide the number of your Acronis
True Image Personal copy bundled with the program. This number is made up of
five sets of five characters separated by hyphens; there is a total of 25 letters and
numbers.
For more information visit http://www.acronis.com/support/
Technical support e-mail address: support@acronis.com.
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Appendix A.
A.1

Partitions and file systems

Hard disk partitions
The mechanism that allows you to install several operating systems on a single PC
or to carve up a single physical disk drive into multiple “logical” disk drives is called
partitioning.
Partitioning is performed by special applications. In MS-DOS and Windows, these
are FDISK and Disk Administrator.
Partitioning programs perform the following:
• create a primary partition
• create an extended partition that can be split into several logical disks
• set an active partition (applied to a single primary partition only)
Information about partitions on a hard disk is stored in a special disk area – in the 1st sector
of cylinder 0, header 0, which is called the partition table. This sector is called the master boot
record, or MBR.
A physical hard disk might contain up to 4 partitions. This limit is forced by the partition table
that is suitable for 4 strings only. However, this does not mean you can have only 4 operating
systems on your PC! Actually, existing applications called disk managers support far more
operating systems on disks. For example, Acronis OS Selector enables you to install up to 100
operating systems!

A.2

File systems
An operating system gives the user the ability to work with data by supporting some
type of file system on a partition.
All file systems are made of structures that are necessary to store and manage
data. These structures are usually composed of operating system boot sectors,
folders and files. File systems perform the following basic functions:
• track occupied and free disk space (and bad sectors, if any)
• support folders and file names
• track physical location of files on disks
Different operating systems use different file systems. Some operating systems are
able to work with only one file system while others can use several of them. Here
are some of the most widely used file systems .
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A.2.1

FAT16
The FAT16 file system is widely used by DOS (DR-DOS, MS-DOS, PC-DOS, PTS-DOS
and other), Windows 98/Me, and Windows NT/2000/XP operating systems and is
supported by most other systems.
Main features of FAT16 are the file allocation table (FAT) and clusters. FAT is the
core of the file system. To increase data safety, it is possible to have several copies
of the FAT (there are usually two of them) on a single disk. A cluster is a minimum
data storage unit in FAT16 file system. One cluster contains a fixed number of
sectors. FAT stores information about what clusters are free, what clusters are bad,
and also defines in which clusters files are stored.
The FAT16 file system has a 2GB limit that permits a maximum 65,507 clusters that
are 32Kb in size. (Windows NT/2000/XP support partitions up to 4GB with up to
64Kb clusters). Usually the smallest cluster size is used to make the total cluster
amount within the 65,507 range. The larger a partition is, the larger its clusters are.
Usually the larger the cluster size, the more disk space is wasted. A single byte of data could
use up one cluster, whether the cluster size is 32Kb or 64Kb.

Like many other file systems, the FAT16 file system has a root folder. Unlike others,
however, its root folder is stored in a special place and is limited in size (standard
formatting produces a 512-item root folder).
Initially, FAT16 had limitations on file names. They could only be eight characters
long, plus a dot, plus three characters of name extension. However, long-name
support in Windows 95 and Windows NT bypasses this limitation. The OS/2
operating system also supports long names, but does so in a different way.
A.2.2

FAT32
The FAT32 file system was introduced in Windows 95 OSR2. It is also supported by
Windows 98/Me/2000/XP. FAT32 is an evolved version of FAT16. Its main
differences from FAT16 are 28-bit cluster numbers and a more flexible root, whose
size is unlimited. The reasons FAT32 appeared are the support of large hard disks
(over 8GB in capacity) and the impossibility to implement any more complex file
system into MS-DOS, which is still the base for Windows 98/Me.
The maximum FAT32 disk size is 2 terabytes (1 terabyte, or TB, is equal to 1024
gigabytes, or GB).

A.2.3

NTFS
NTFS is the main file system for Windows NT/2000/XP. Its structure is closed, so no
other operating system is fully supported. The main structure of NTFS is the MFT
(master file table). NTFS stores a copy of the critical part of the MFT to reduce the
possibility of data damage and loss. All other NTFS data structures are special files.
NTFS stands for NT File System.
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Like FAT, NTFS uses clusters to store files, but cluster size does not depend on
partition size. NTFS is a 64-bit file system. It uses unicode to store file names. It is
also a journaling (failure-protected) file system, and supports compression and
encryption.
Files in folders are indexed to speed up file search.
A.2.4

Linux Ext2
Ext2 is one of the main file systems for the Linux operating system. Ext2 is a 32-bit
system. Its maximum size is 16TB. The main data structure that describes a file is
an i–node. A place to store the table of all i-nodes has to be allocated in advance
(during formatting).

A.2.5

Linux Ext3
Officially introduced with its version 7.2 of the Linux operating system, Ext3 is the
Red Hat Linux journaling file system. It is forward and backward compatible with
Linux ext2. It has multiple journaling modes and broad cross-platform compatibility
in both 32- and 64-bit architectures.

A.2.6

Linux ReiserFS
ReiserFS was officially introduced to Linux in 2001. ReiserFS overcomes many Ext2
disadvantages. It is a 64-bit journaling file system that dynamically allocates space
for data substructures.
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